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Quick Start Guide
Thank you for purchasing this FUJIFILM product.
This Quick Start Guide explains how to connect the FUJIFILM Digital Camera
FinePix S2 Pro to a personal computer and how to install the software. It also
describes the basic operation of the software. Read this guide carefully to
ensure that you use this product correctly.
For detailed information on using the Hyper-Utility Software, refer to the PDF-
format manuals that are installed with the software.

E

Hyper-Utility Software
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IMPORTANT
Be sure to read this page before using the Software.

This Quick Start Guide is intended for users who already have a basic grasp of their computer and
its operating system (Windows or Mac OS). If you encounter unfamiliar terms or procedures while
reading this Quick Start Guide, refer to the manuals supplied with your computer or its operating
system.

• Microsoft and Windows are trademarks of the Microsoft Corporation of the U.S. registered in the
U.S. and other countries.
Windows is an abbreviated term referring to the Microsoft Windows Operating System.

• Macintosh, iMac and Mac OS are registered trademarks of Apple Computer, Inc.
• QuickTime and the QuickTime logo are trademarks used under license. The QuickTime logo is

registered in the U.S. and other countries.
• Adobe, Adobe Photoshop and Adobe Acrobat are trademarks of Adobe Systems Incorporated or

trademarks of Adobe Systems Incorporated registered within particular jurisdictions.
• Pentium and Celeron are trademarks of the Intel Corporation of the U.S.
• All other company or product names are trademarks or registered trademarks of the respective

companies.

a
Do not attempt to play the CD-ROM enclosed with this product on
an audio CD player. Doing so could damage your hearing or could
damage your speakers or headphones.

This End User License Agreement (“Agreement”) is an agreement between Fuji Photo Film Co., Ltd.
(“FUJIFILM”) and you, which sets forth the terms and conditions of the license granted for you to use
the software provided by FUJIFILM.
The CD-ROM contains third party software. In case a separate agreement is provided by a third
party supplier for its software, the provisions of such separate agreement shall apply to the use of
such third party software, prevailing over those of this Agreement.

1. Definitions.
(a) “Media” means the CD-ROM titled “Hyper-Utility Software” which is provided to you together with this

Agreement.
(b) “Software” means the software which is recorded on Media.
(c) “Documentation” means the operation manuals of Software and other related written materials which are

provided to you together with Media.
(d) “Product” means Media (including Software) and Documentation collectively.

2. Use of Software.
FUJIFILM grants to you a nontransferable, nonexclusive license:
(a) to install one copy of Software onto one computer in binary machine executable form;
(b) to use Software on the computer onto which Software is installed; and
(c) to make one backup copy of Software.

3. Restrictions.
3.1 You shall not distribute, rent, lease or otherwise transfer all or any part of Software, Media or Documentation

to any third party without FUJIFILM’s prior written consent. You also shall not sublicense, assign or otherwise
transfer all or any part of the rights granted to you by FUJIFILM under this Agreement without FUJIFILM’s
prior written consent.

3.2 Except as expressly granted by FUJIFILM hereunder, you shall not copy or reproduce all or any part of
Software or Documentation.

3.3 You shall not modify, adapt or translate Software or Documentation. You also shall not alter or remove
copyright and other proprietary notices that appear on or in Software or Documentation.

3.4 You shall not, or shall not have any third party, reverse-engineer, decompile, or disassemble Software.

4. Ownership.
All copyrights and other proprietary rights to Software and Documentation are owned and retained by FUJIFILM
or the third party suppliers as indicated on or in Software or Documentation. Nothing contained herein shall be
construed, expressly or implicitly, as transferring or granting any right, license, or title to you other than those
explicitly granted under this Agreement.

5. Limited Warranty.
FUJIFILM warrants to you that Media is free from any defect in material and workmanship under normal use for
ninety (90) days from the date of your receipt of Media. Should Media not meet the foregoing warranty, FUJIFILM
shall replace such defective Media with other Media bearing no defect. FUJIFILM’s entire liability and your sole
and exclusive remedy with regard to any defect in Media shall be expressly limited to such FUJIFILM’s
replacement of Media as provided herein.

6. DISCLAIMER OF WARRANTY.
EXCEPT AS PROVIDED IN SECTION 5 HEREIN, FUJIFILM PROVIDES PRODUCT “AS IS” AND WITHOUT
WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED. FUJIFILM SHALL MAKE NO WARRANTY, EXPRESS,
IMPLIED OR STATUTORY, AS TO ANY OTHER MATTERS, INCLUDING, BUT NOT LIMITED TO NON-
INFRINGEMENT OF ANY COPYRIGHT, PATENT, TRADE SECRET, OR ANY OTHER PROPRIETARY
RIGHTS OF ANY THIRD PARTY, MARCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE.

NOTICE
BEFORE OPENING THE PACKAGE OF CD-ROM PROVIDED BY FUJI PHOTO FILM CO., LTD.,
PLEASE READ THIS END USER LICENSE AGREEMENT CAREFULLY. ONLY IF YOU DO
AGREE TO THIS AGREEMENT, YOU WILL BE ABLE TO USE THE SOFTWARE RECORDED
ON THE CD-ROM. BY OPENING THE PACKAGE, YOU ACCEPT AND AGREE TO BE BOUND
BY THIS AGREEMENT.

End User License Agreement

7. LIMITATION OF LIABILITY.
IN NO EVENT SHALL FUJIFILM HAVE ANY LIABILITY FOR ANY GENERAL, SPECIAL, DIRECT, INDIRECT,
CONSEQUENTIAL, INCIDENTAL, OR OTHER DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS
OR LOST SAVINGS) INCURRED FROM THE USE OF OR INABILITY TO USE PRODUCT EVEN IF FUJIFILM
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

8. No export.
You acknowledge that neither Software nor any part thereof, will be transferred, or exported to any country or
used in any manner in violation of any export control laws and regulations to which Software is subject.

9. Termination.
In case you breach any of the terms and conditions hereof, FUJIFILM may immediately terminate this Agreement
without any notice.

10. Term.
This Agreement is effective until the date when you cease to use Software, unless earlier terminated in
accordance with Section 9 hereof.

11. Obligation upon termination.
Upon termination or expiration of this Agreement, you shall, at your own responsibility and expense, delete or
destroy immediately all Software (including its copies), Media and Documentation.

12. Governing Law.
This Agreement shall be governed by and construed in accordance with laws of Japan.
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1 Introduction
Thank you for purchasing this FUJIFILM product.
The Hyper-Utility Software comprises the following products for professional
users of the Digital Camera FinePix S2 Pro (referred to hereafter simply as
the “camera”).
h RAW FILE CONVERTER EX
h CAMERA SHOOTING SOFTWARE

RAW FILE CONVERTER EX is software that converts CCD-RAW data shot on the
camera to TIFF image files.
The CAMERA SHOOTING SOFTWARE allows you to connect the camera to your
computer and then take pictures and specify the photography settings from the
computer.
This Guide briefly describes how to install and use the Hyper-Utility Software.
For detailed information on using the software, refer to the “User's Guide” (PDF file) ✽

installed on your computer.
✽ To read the “User’s Guide” (PDF file), Adobe Systems' Acrobat Reader must be

installed on your computer.

Package Contents
Before using this product, check that your package contains all the items
listed below.
h Hyper-Utility Software CD-ROM (1)
h Hyper-Utility Software Quick Start Guide (1)

Main Features
� RAW FILE CONVERTER EX
h Can be used to convert CCD-RAW files to 16-bit TIFF files with ICC profiles or Exif-

TIFF(RGB) files.
h Allows you to specify parameters such as the tone curve, white balance, sharpness,

saturation and brightness during the conversion.
h Allows you to preview the image converted using the specified conversion

parameters.

� CAMERA SHOOTING SOFTWARE
Allow you to connect the camera to your computer’s IEEE1394 interface and
do the following:
h Set the camera’s photography settings and take pictures from the computer.
h Select the desired image size and file format, and save photographed images as files.
h Check photographed images in a window on your computer before saving them as

files.
h Use your computer’s hard disk as a storage media for the camera.

4

Symbols Used in This Guide
The symbols listed below are used throughout this guide.

q Indicates a camera operation must be performed. Refer to the Owner’s
Manual for your camera.

Indicates important precautions to follow when using the software.
✽ Indicates important information.
� Indicates notes or additional information.

Indicates useful tips.TIP
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2 Hyper-Utility Software

6

System Requirements
Check that your computer system meets the hardware and software
requirements listed below for using the Hyper-Utility Software.

� Windows PCs
Model: PC with a Pentium III, 4, Celeron or later processor with 

Windows Millennium Edition, Windows 2000 Professional or 
Windows XP Home/Professional pre-installed ✽1

Hard disk: Min. 1 GB available space
RAM: 256 MB (512 MB or better recommended)
Screen resolution: 1024 × 768 or better

16-bit color (65536 colors) or better
Operating System: Windows Millennium Edition, Windows 2000 Professional SP2 or

later, or Windows XP Home/Professional
IEEE1394 board: OHCI-compliant IEEE1394 interface board (required for using the

CAMERA SHOOTING SOFTWARE) ✽2

IEEE1394 cable: IEEE1394 cable bundled with the camera
CD-ROM drive: Required for software installation

✽1 This software is not guaranteed to run on home-made PCs or PCs running updated
operating system software.

✽2 Operation is not guaranteed for connections via an IEEE1394 (FireWire) hub.
✽ This software cannot be used via a USB connection.

� Macintosh Computers
Model: Power Macintosh G3, Power Macintosh G4, PowerBook G3,

PowerBook G4 or iBook with an IEEE1394 (FireWire) interface as a
standard feature ✽1

Hard disk: Min. 1 GB available space
RAM: 256 MB (512 MB or better recommended) ✽2

Screen resolution: 1024 × 768 or better
32000 color or better

Operating system: Mac OS 9.1 to 9.2 ✽3

IEEE1394 cable: IEEE1394 cable bundled with the camera
CD-ROM drive: Required for software installation

✽1 This software is not guaranteed to run when used via an IEEE 1394 (FireWire) hub
or with an added IEEE 1394 port.

✽2 Allocate at least 400 MB of virtual memory for RAW FILE CONVERTER. If other
applications are to be used with RAW FILE CONVERTER, allocate sufficient
memory capacity for the other applications also.

✽3 This software does not run correctly in the Mac OS X Classic environment.
✽ CAMERA SHOOTING SOFTWARE cannot be used with a USB connection.

FinePix S2 Pro

Computer

Hyper-Utility Software

xAllows the camera to be controlled and shots to be taken from a computer.
xImages photographed with the camera can be automatically saved on the computer.

Special USB cable

USB driver

Shooting driver

IEEE 1394 cable

CAMERA SHOOTING �
SOFTWARE

xConverts CCD-RAW 
images to TIFF files

RAW FILE CONVERTER EX

FinePixViewer

AdobeR PhotoshopR✽

✽ Adobe Photoshop is not included in the Hyper-Utility Software.

ＰＣＰＣ ＭＯＤＥＭＯＤＥ� １３９４　ＳＨＯＯＴＩＮＧ１３９４　ＳＨＯＯＴＩＮＧ�
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3 Installing the Software
3-1 For Windows PCs

1. Switch on your PC and start up Windows.
✽ If you have already switched on your PC, restart your PC at this point.

Users of Windows 2000 or Windows XP should log in using a system administrator
account (e.g. “Administrator”).

2. Quit all other active applications until no applications are
shown in the taskbar.

1 Click the right mouse button on the application icon in the taskbar.
2 Click “Close” in the menu that appears to quit the application.
✽ For more information, refer to the instructions provided with your PC and

applications (antivirus software, etc.).

If a “----.dll file not found.” message appears during installation, there is another
application running in the background. Forcibly shut down the application. Refer to your
Windows manuals for information on how to forcibly shut down an application.

3. Load the Hyper-Utility Software CD-ROM into the CD-ROM
drive. The installer starts up automatically.

NOTE

NOTE

Load the CD-ROM into your PC

<Taskbar>

Applications to be shut down
(the icons shown vary depending on
the applications that are running)

Do not connect the camera to your PC until the software
installation is completed.

1

Launching the Installer Manually

1. Double-click the “My Computer” icon.
✽ Windows XP users should click “My Computer” in the “Start” menu.

2. Right-click “HS-S2” (CD-ROM drive) in the “My Computer”
window and select “Open”.

3. Double-click “SETUP” or “SETUP.exe” in the CD-ROM
window.

✽ The way file names are displayed differs as described below depending on your
computer settings.
• File extensions (3-letter suffixes indicating the file type) may be shown or

hidden. (e.g. Setup.exe or Setup)
• Text may be shown normally or all in uppercase (e.g. Setup or SETUP).

4. Pre-installation checking begins. If any warning messages
appear, follow the instructions given on the screen.

✽ The “Add New Hardware Wizard” may be hidden behind the “Note” message.
Check the taskbar, move the message window and then click the [Cancel] button.

5. A confirmation message appears asking whether you want to
continue with the installation. Click the [OK] button.
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3 The screen shown at right may
appear. To continue with the
settings, click the [Yes] button.

6. The RAW FILE CONVERTER LE is installed.

7. The RAW FILE CONVERTER EX is installed.

8. Install CAMERA SHOOTING SOFTWARE as directed by the
on-screen instructions.

9. Install QuickTime as directed by the on-screen instructions.
✽ If you have already installed QuickTime version 5.0.2 or later, this installation is

not performed.

From Hyper-Utility Software installation to restart

1. The Setup screen appears.
Click the [Install Hyper-Utility
Software] button.
✽ For more information on what is

installed, click the [Explanation]
button.

2. The software version is
checked. If the window
shown at right appears, click
the [OK] button to uninstall
the software.

3. The USB drivers are installed.

4. The FinePix S2 Pro shooting driver is installed.

5. Install FinePixViewer.
1 Hyper-Utility Software installation

begins and notes and warnings are
displayed. When you have
confirmed these, click the [Next >]
button.

2 Check the installation destination
folder and then click the [Next >]
button.

2

If the “Connection speed” window
appears, set the correct speed for your
environment of connection and then click
the [Next] button.
✽ If you do not know your connection

speed, simply click the [Next] button.

Click [Agree] button in the “Software
License Agreement” window.
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10. Install Windows Media Player as directed by the on-screen
instructions and then restart your PC.
✽ If the latest version of the software is already installed on your PC, this installation

is not performed. When next screen appears, click the [Restart] button.

11. After you restart your PC, the “How to use FinePixViewer”
page appears in the web browser window. Check the details
before closing the window and proceeding with the
installation.

You must install Adobe Systems’ Acrobat Reader software to read the
FinePixViewer User’s Guide (PDF).
If you already have the latest version installed, this step is not required.

1. Open the “My Computer”
window, right-click the CD-
ROM icon and select “Open”
to view the contents of the
CD-ROM.

2. Double-click “SETUP” or “SETUP.exe”.

3. In the installer window, click
the [Install Acrobat Reader]
button.

4. Proceed with the installation as directed by the on-screen
instructions.

Acrobat Reader installation3

This completes the installation of all the software
components.

3-2 Macintosh Computers

� Enable File Exchange
Check whether File Exchange is active.
To use a Media that is supported by the camera, the File Exchange utility
supplied with Mac OS must be running.  

1. Switch on your Macintosh and start up Mac OS 9.1 to 9.2.

Do not connect the camera to your Macintosh until the software installation is
completed.

2. Select the Extensions Manager in the Control Panels and
check that the File Exchange check box is ticked. If not, click
in the box so that an appears and then restart your
Macintosh.

NOTE

Check the system software settings

From Hyper-Utility Software installation to restart

1. When you load the Hyper-Utility Software CD-ROM into the
CD-ROM drive, the “HS_S2” window automatically opens.

If the “HS_S2” window does not open automatically,
double-click the CD-ROM icon.

NOTE

1

2

In this window, tick the “I have read the
Privacy Statement” checkbox and then
click the [Next >] button.

When you click the [Restart] button, your
PC is restarted.
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2. Double-click “Installer for MacOS9.1-9.x” to launch the
Installer.

3. A confirmation message appears asking whether you want to
continue with the installation. Click the [OK] button.

4. The Installer setup screen appears.
Click the [Install Hyper-Utility Software] button.
✽ For more information on what is

installed, click the [Explanation]
button.

5. Select the installation destination for Hyper-Utility Software.
1 Click the [Open] button to open the

installation destination folder.

2 Click the [Save] button.

Click [Agree] button in the “License”
window.

6. Install QuickTime as directed by the on-screen instructions
and then restart your Macintosh.
✽ If you have already installed QuickTime version 5.0.2 or later, this installation is

not performed.

7. After you restart your Macintosh, the “How to use
FinePixViewer” alias is created on the desktop. Use your
browser software to check the details and then proceed with
the installation.

If the “Connection Speed” window appears
after your restart your Macintosh, set the
correct speed for your environment of
connection and then click the [Next] button.
✽ If you do not know your connection

speed, simply click the [Next] button.



16 17

Acrobat Reader installation3
You must install Adobe Systems’ Acrobat Reader software to read the
FinePixViewer User’s Guide (PDF).
If you already have the latest version installed, this step is not required.

1. Double-click the “Installer for MacOS9.1–9.x” icon to launch
the installer.

2. A confirmation message appears asking whether you want to
continue with the installation. Click the [OK] button.

3. The installer setup window appears.
Click the [Install Acrobat Reader] button.

4. Install Acrobat Reader as directed by the on-screen
instructions.

When you install Hyper-Utility Software, PDF-format user manuals are also
installed at the same time.
Shortcuts (Windows) or aliases (Macintosh) for the PDF files are created on
the desktop.
You can view the respective manuals in Acrobat Reader by double-clicking on
the shortcut/alias.

This completes the installation of all the software
components.

4 Reading the User’s Guide

CAMERA SHOOTING SOFTWARE Manual

RAW FILE CONVERTER EX Manual
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Operation Flow15 Software Basics
5-1 Using RAW FILE CONVERTER EX

RAW FILE CONVERTER EX is software that converts CCD-RAW data shot
on the Digital Camera FinePix S2 Pro to TIFF image files.
The converted images are saved as 16-bit TIFF files, and ICC profile
embedding can be selected to allow the files to be used without problems in
Adobe® Photoshop® 6.0. Color spaces such as Adobe RGB (1998) and
FUJIFILM’s own FinePixRGB 1.8 can be used with ICC profiles. 
This software also supports conversion to the Exif-TIFF(RGB) format normally
used for image exchange over the Internet.
In signal processing in RAW FILE CONVERTER EX, considerable care is
taken to avoid any loss of image quality, with first-stage processing at the
lower limit that cannot be converted in Adobe® Photoshop®. This ensures that
you make the most of the capabilities the Digital Camera FinePix S2 Pro.

CCD-RAW files contain image data that is shot on a digital camera and saved
before any signal processing is performed. Consequently, you cannot view the
content of CCD-RAW files using an ordinary application program (such as
Windows Explorer or an image viewer).
This Guide describes the steps involved in using RAW FILE CONVERTER EX
to convert CCD-RAW files to TIFF files and then opening the converted files in
Adobe® Photoshop®.
✽ Exif-TIFF (RGB) is an 8-bit baseline TIFF format. Because this standard does not

allow embedding of ICC profiles, specify the sRGB IEC61966-2.1 color space when
using this image format in applications such as Adobe Photoshop.

Take CCD-RAW shots on the Digital Camera
FinePix S2 Pro.

Download the CCD-RAW files to
a PC using a recording media✽.

Select the images for conversion in
FinePixViewer.

Convert the images in RAW FILE
CONVERTER EX.

For Adobe® Photoshop®

USB
download

IEEE 1394
download

Using a recording media

16 bit TIFF file
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Thumbnail list display YES

Function Support

Image information display YES

Playback pane YES

Slideshows YES

CD Album maker NO

Uploads NO

DPOF settings NO

Printing NO

Index printing YES

Batch resizing NO

Batch rotation NO

Batch format conversion NO

Automatic renaming YES

Playback (open) NO

CCD-RAW files can be viewed as thumbnail images in FinePixViewer. They
can also be used in index printing. The table below shows the functions
supported for CCD-RAW images in FinePixViewer.

q Copy the CCD-RAW files to your hard disk.

w Use the mouse to select the image to be converted. You can
select multiple images by holding down the Ctrl key as you
click the images.

e Click this button to launch RAW FILE CONVERTER EX.

Viewing Converted Images2

0e

0w

Selecting Images for Conversion and Launching RAW FILE CONVERTER EX3

Specifying the Conversion Color Space4
When you launch RAW FILE
CONVERTER EX, a window appears
in which you select the file format and
the color space to be used for
converted images. Select the color
space and file format based on the
descriptions provided and then click
the [OK] button.

The table below lists the parameters that you can specify in RAW FILE
CONVERTER EX.

Setting

Photography settings

Images are converted based on the camera settings when the
shots were taken. This allows greater accuracy in conversion
processing equivalent to Exif-JPEG or Exif-TIFF(RGB) photography
on the camera.

Images are converted based on the tone curve settings selected on
the camera when the shots were taken.

You can select STANDARD, HARD or ORIGINAL as the tone curve
setting.

This option allows you to create a customized tone curve for
displaying graphics.

If the “Use custom settings” checkbox is not selected, images are
converted based on the white balance settings selected on the
camera when the shots were taken.

You can select AUTO, FINE, SHADE, Daylight Fluorescent Lamp,
Daytime White Fluorescent Lamp, Cool White Fluorescent Lamp,
INCANDESCENT LIGHT, COSTOM 1 or CUSTOM 2 as the white
balance setting.

This option allows you to set the white balance by picking a gray
spot in the image.

This option allows you to manually set the color temperature for
shooting conditions.

If the “Use custom settings” checkbox is not selected, images are
converted based on the sharpness settings selected on the camera
when the shots were taken.

You can select STANDARD, HARD or OFF as the sharpness setting.

Custom settings
not used

Standard curve

Manual settings

Custom settings
not used

Standard light
source

Gray picker

Set color
temperature

Custom settings
not used

Set manually

If the “Use custom settings” checkbox is not selected, images are
converted based on the saturation settings selected on the camera
when the shots were taken.

You can select STANDARD, HIGHT, ORIGINAL or B/W as the
saturation setting.

Custom settings
not used

Set manually

If the “Use custom settings” checkbox is not selected, images are
converted without intensification.

Custom settings
not used

You can specify intensification settings between –1.0 EV and +3.0
EV in 1/3 EV increments.Set manually

C
ustom

settings

T
one

curve
W

hite
balance

Details

S
harpness

C
olor

Sensitization

You can also make fine adjustments to the white balance by moving the point in the
RGB space.
In addition, you can save white balance settings to a file and import saved settings from
a file.

Setting the Conversion Parameters in RAW FILE CONVERTER EX5



22 23

q Preview image: Allows you to check the results of conversion performed using the settings
beforehand.

w When the Gray picker is used, this shows the coordinates and the R, G and B values for
the selected point. The R, G and B values for pure white are given as (255, 255, 255).

e Displays the input and output file names.
r Destination file format: Displays the format and color space of the converted TIFF file.
t Use these radio buttons to specify the image size for TIFF files.
y Photography settings: Use these radio buttons to select whether the settings on the

camera when the shot was taken or the custom settings specified in
this software are used for all the parameters.

u Tone curve: Allows you to set the tone curve.
i White balance: Allows you to specify a custom white balance.
o You can make fine adjustments to the white balance by moving the point around with the

mouse.
!0 This allows you to return to the previous step in setting the white balance.
!1 Sharpness: Allows you to specify the sharpness setting.
!2 Color: Allows you to specify the saturation.
!3 Sensitization: Allows you to alter the brightness by changing the intensification setting.

0q

0w

0e

0r

0t

0y

0u

0i

0!1 0!2

0!3

0!0

0o

You can change the window size and enlarge the preview image by dragging
the bottom right corner of the window with the mouse.

Drag with the mouse.

If you specify the output image size and click the [Convert] button, the CCD-
RAW file is converted to a TIFF file. The table below lists the available output
sizes.

Click the button in the top-right corner of the screen.

The TIFF file is created in the same folder as the CCD-RAW file with an
underscore (_) and number added to the original file name and the file
extension changed to TIF (e.g. DSCF0001_1.TIF). If a file with this name
already exists, the number after the underscore is automatically updated (e.g.
DSCF0001_2.TIF).

Output Size

4256 × 2848

3024 × 2016

2304 × 1536

1440 × 960

Converting Image Files with RAW FILE CONVERTER EX6

Exiting RAW FILE CONVERTER EX7
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5-2 CAMERA SHOOTING SOFTWARE Basics
The following camera functions are not supported in the CAMERA
SHOOTING SOFTWARE:
h Voice memo function
h Multi-exposure shooting

� Connecting to a Camera
If you connect the camera via an IEEE 1394 port, check that the interface is
OHCI-compliant.
On Macintosh computers, use the computer's built-in IEEE 1394 port.

Camera connection1

1. Switch on your PC.

2. Connect the AC power adapter to the camera and switch the
camera on. In the Setup screen, select “PC MODE > 1394
SHOOTING” and then close the Setup screen.
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3. Connect the camera to your PC using a IEEE1394 cable.

• CAMERA SHOOTING SOFTWARE can only be used with one camera at a time.
• Connect the camera and PC using a direct IEEE1394 cable connection. The software

may not run correctly if the camera is connected through a bridge or hub.
• If you are using Windows 2000, the “Digital Signature Not Found” message window

appears the first time you connect the camera after installing the software from the
Hyper-Utility Software CD-ROM. Click [Yes] and continue with the installation.

• Use a CHCI-compliant product as the IEEE 1394 interface.

CAUTION

Launching the software2
1. Start up CAMERA SHOOTING SOFTWARE.

Double-click the “CAMERA SHOOTING SOFTWARE” shortcut
(Windows) or alias (Macintosh) on the desktop.

2. After the opening splash screen, a window appears in which
you can select the camera to be used. Select your camera.

If the camera is not shown, restart your computer and switch the camera off and then on
again.

3. When the camera control mode selection window appears,
select the camera control mode.

NOTE
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2. Check the photographed image.

Click

If you click the image you want to check in the Scroll Preview in
the Shooting window, the image is displayed in the Large
Preview window.

You can use the Large Preview window to check an image you
have shot.

Large Preview window

PC Control Mode3

1. Take a picture.
Specify the photography settings and click the [Apply]
button. Then click the [Shoot] button.
✽ Refer to the User’s Guide PDF file for more information on the photography

settings.

Shooting window

PC Control mode allows you to control the camera from your computer. You
can specify the photography settings and take pictures (release the shutter)
from your computer.
Photographed images can be checked in the Large Preview window and then
saved with a user-selected image size and file format.
✽ “1394 SHOOTING” is displayed on the camera’s rear display panel.
✽ The “Metering mode”, “AF area mode” and “Change AF area” camera settings cannot

be used in PC Control mode.

3. Click

2. Click

1. Specify the
shooting
condition
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Camera Control (Normal) mode4
In Camera Control (Normal) mode, you use the controls on the camera to set
the photography settings and release the shutter. You can check
photographed images in the Large Preview window on your computer and
then specify the image size and file format in which the image is saved.
✽ “1394 SHOOTING” is displayed on the camera’s rear display panel.
✽ In Camera Control (Normal) mode, you cannot use the camera settings to switch to

the “SET-UP” or “CUSTOM” screens without first erasing all the photographed
images.

1. Take a picture.
Take the picture using the camera controls as described in the camera’s
Owner’s Manual. Pictures are taken using the camera’s internal memory,
which holds 7 frames. Once the internal memory is full, no further shots
can be taken.

The Large Preview window displayed is the same as that shown in PC Control
mode.
While the Large Preview window is displayed behind the Shooting window in
PC Control mode, in Camera Control mode the Large Preview window
appears in the front.

2. Check the photographed image.

Large Preview window

3. Save the photographed image at the desired size in the
desired file format.

4. Exit the software.
To exit the CAMERA SHOOTING SOFTWARE, select “Exit” from the
“File” menu in the Shooting window. On Macintosh computers also, select
“Exit” from the “File” menu.
You can also exit the CAMERA SHOOTING SOFTWARE by clicking the
Close button in the top-right corner in the Windows version or the Close
box in the top-left corner in the Macintosh version.

Photographed images can be downloaded to your computer
using either Save As or Save.
✽ “1394 SHOOTING” is displayed on the camera’s rear display panel.
✽ Refer to the User’s Guide PDF file for more information on saving images.
✽ If there are any images left in the camera's internal memory, a PC icon flashes

( ) on the camera's rear display panel.
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2. Take a picture.
Take the picture using the camera controls as described in the camera’s
Owner’s Manual. Pictures are taken using the camera’s internal memory,
which holds 7 frames. Photographed images are automatically
downloaded to the computer. Once they have been saved on the
computer’s hard disk, the images are erased from the camera’s internal
memory.
In modes where the camera’s internal memory becomes full, such as
continuous shooting, no further shots can be taken. However, as soon as
downloading of the images ends, the next series of shots can be taken.
However, as soon as downloading of the images ends, the next series of
shots can be taken.

1. If CAMERA SHOOTING SOFTWARE is running, exit the
program and then perform the procedure that precedes
switching off the camera. This procedure varies depending
on the operating system (or computer) you are using.

1 Left-click the Eject icon in the taskbar.

Windows Me

2. Switch off the camera and disconnect the IEEE1394 cable.

Always use the correct disconnection procedure in Windows Me.

NOTE

2 When the Stop menu item appears, click the menu item.

3 The “Disconnect hardware” dialog box now appears. Click the [OK] button or
Close button.

3. Exit the software.

Perform the steps shown below before you switch the camera off. This
procedure differs depending on the operating system software (or PC) you are
using.

Disconnecting the camera6Camera Control (Auto Acquire) mode5
In Camera Control (Auto Acquire) mode, you use the controls on the camera
to set the photography settings and release the shutter.
On the computer you simply specify the folder in which images are to be
saved and all subsequent operations are performed by the camera. In this
mode, the computer is effectively used as a storage media for the camera.
✽ “1394 SHOOTING” is displayed on the camera's rear display panel.
✽ In Camera Control (Auto Acquire) mode, you cannot use the camera settings to switch

to the “SET-UP” or “CUSTOM SETTING” screens until all the photographed images
have been erased. Wait until all the images have finished downloading before
proceeding.

✽ If there are any images left in the camera’s internal memory, a PC icon flashes
( ) on the camera's rear display panel.

3. Save the photographed image at the desired size in the
desired file format.
Photographed images can be downloaded to your computer using either
Auto Save or Save.
✽ Refer to the User’s Guide PDF file for more information on saving images.

5. Exit the software.

4. Erase the photographed images from memory.
Erasing the images that have been downloaded to the
computer from the camera’s memory allows you to take more
pictures. Select the thumbnails for the images you want to
erase and click the [Erase] button.

1. Specify the save destination folder.

Information window

✽ Windows Me screen.



3332

7. When the confirmation message appears, click the [OK]
button. Check your selection carefully since the process
cannot be cancelled once you click [OK].

8. Automatic uninstallation begins.
When uninstallation ends, click the [OK] button.

Only perform this operation when you no longer require the installed software or when
the software was not installed correctly.

Mac OS 9.1–9.2

NOTE

Macintosh

Uninstalling Drivers

1. Check that the camera is not connected to your Macintosh.

2. Open the “Extensions” folder inside the System folder on
your Macintosh’s hard disk (the startup disk) and drag all the
files that begin with “USB04CB...” and following 8 files to the
Trash.
FFTIFF16_Lib FTL1394_Lib
FF05DA0D_Lib FTL1394_SBP2_Drv
FF05DA0D_FCR FTL1394_SBP2_Expert
SU400Api_Lib FTL1394_SBP2_Family

3. Restart your Macintosh.

4. Select “Empty Trash” in the “Special” menu.

1. After you have quit Exif Launcher in “Exif Launcher Settings”
in the FinePixViewer “Settings” menu, move the Exif
Launcher file from the “Startup Items” folder in the System
folder to the Trash. Then select “Empty Trash” in the
“Special” menu.

2. After you have exited FinePixViewer and CAMERA
SHOOTING SOFTWARE and then drag the installed
FinePixViewer and CAMERA SHOOTING SOFTWARE folder to
the Trash. Then click “Empty Trash” in the “Special” menu.

Uninstalling Hyper-Utility Software

6 Uninstalling the Software

q See “Connection” in
the camera Owner’s
Manual.

Only perform this operation when you no longer require the installed software.

1. Switch on your PC.

2. Disconnect the camera.

3. Quit all currently running applications.

4. Close all files.

5. Open the “My Computer” window and
double-click “Add/Remove Programs” in
the Control Panel.

6. The “Add/Remove Programs Properties” window appears.
Select the software to be uninstalled (CAMERA SHOOTING
SOFTWARE, RAW FILE CONVERTER EX FinePixViewer or the
driver) and then click the [Add/Remove] button.

Windows

<To remove FinePixViewer>

<To remove FUJIFILM S2 Pro SHOOTING Driver>

<To remove RAW FILE CONVERTER LE>

<To remove RAW FILE CONVERTER EX>

<To remove CAMERA SHOOTING SOFTWARE>

<To remove the USB driver software>
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To ensure that color space information selected by RAW
FILE CONVERTER EX is recognized correctly by Adobe
Photoshop, the profile must be specified correctly in
Adobe Photoshop.

� In Windows
[Settings for Adobe Photoshop 6.0]

1. Select “Edit” → “Color Settings”

2. From the “RGB” pop-up menu in the workspace frame,
specify the color space selected during image conversion in
RAW FILE CONVERTER EX.
For sRGB: Select “sRGB IEC61966-2.1”.
For AdobeRGB (1998): Select “AdobeRGB (1998)”.
For FinePixRGB 1.8: Select “FinePixRGB 1.8”.

3. Specify “Preserve embedded profiles” in the “RGB” pop-up
menu in the Color Management Policy frame.

4. Click the [OK] button.

7 Appendix
Color Spaces Supported by RAW FILE CONVERTER EX

RAW FILE CONVERTER EX allows you to select the output color space.

1. AdobeRGB (1998)
This was introduced as the working color space for Adobe Photoshop 5.0.
It incorporates colors that can be reproduced on almost all CMYK printers
and is best suited to printing. This color space was introduced as
“SMTPE-240E” in the RGB setting for Adobe Photoshop 5.0, and as
“AdobeRGB (1998)” in the profile settings for version 6.0 onwards.

2. FinePixRGB 1.8
This color space applies a g value of 1.8 and is the standard color space
used on Macintosh computers. FinePixRGB 1.8 uses the same colors as
AdobeRGB (1998) and is best suited to DTP work on Macintosh
computers.

3. sRGB (IEC61966-2.1)
The sRGB color space was formulated by the IEC and is the standard
color space for monitors in Windows systems. This color space defines
average characteristics for a wide range of different monitors and can be
used as the standard color space in operating systems such as Windows.

The term “color space” refers to a range of 2-dimensional or 3-dimensional
numbers that are used to express the colors that can be reproduced on a
camera, display monitor or printer. Figure shows an xy chromaticity diagram
for the sRGB and AdobeRGB color spaces. (An xy chromaticity diagram uses
coordinates to represent color tones in 2 dimensions (brightness is excluded).)
The triangular areas on the xy chromaticity diagram indicate the colors that
can be represented by the color space.
The further out a color appears on the xy chromaticity diagram, the brighter
the color. This method for expressing colors is capable of showing all existing
colors. 

To ensure that the color space information selected in RAW FILE
CONVERTER EX is recognized correctly by Adobe Photoshop, the profile
must be specified correctly in Adobe Photoshop.
Specify the following settings before opening the image.
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� In Macintosh
[Settings for Adobe Photoshop 6.0]

1. Select “Edit” → “Color Settings”

2. From the “RGB” pop-up menu in the workspace frame,
specify the color space selected during image conversion in
RAW FILE CONVERTER EX.
For sRGB: Select “sRGB IEC61966-2.1”.
For AdobeRGB (1998): Select “AdobeRGB (1998)”.
For FinePixRGB 1.8: Select “FinePixRGB 1.8”.

3. Specify “Preserve embedded profiles” in the “RGB” pop-up
menu in the Color Management Policy frame.

4. Click the [OK] button.

[About Photoshop Elements]

1. Select “Edit” → “Color settings”

2. In the Color Settings box, specify the color management
setting method for the color space selected in RAW FILE
CONVERTER EX.
1 If you selected “sRGB IEC61966-2.1”:

Specify “Limited color management - optimized for Web graphics”.

2 If you selected “AdobeRGB(1998)”:
Specify “Full color management - optimized for Print”.

3. Click the [OK] button.

Because Photoshop Elements does not support 16-bit images, 16-bit/ch TIFF images
are converted to 8-bit/ch when opened. When this happens, the window shown below
appears.

NOTE

When you click [Yes], the image is converted to 8-bit/ch and
displayed.

The FinePixRGB1.8 color space cannot be selected or used in Photoshop Elements.

NOTE
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8 When you have a problem
RAW FILE CONVERTER EX

[About Photoshop Elements]

1. Select “Edit” → “Color settings”

2. In the Color Settings box, specify the color management
setting method for the color space selected in RAW FILE
CONVERTER EX.
1 If you selected “sRGB IEC61966-2.1”:

Specify “Limited color management - optimized for Web graphics”.

3. Click the [OK] button.

Because Photoshop Elements does not support 16-bit images, 16-bit/ch TIFF images
are converted to 8-bit/ch when opened. When this happens, the window shown below
appears.

NOTE

When you click [Yes], the image is converted to 8-bit/ch and
displayed.

2 If you selected “AdobeRGB(1998)”:
Specify “Full color management - optimized for Print”.

Problem Probable Cause Solution
The estimated
remaining time
display is not
correct.

It takes over 15
minutes just to
convert a single
image.

I want to view the
preview image
enlarged.

You are trying to convert a
CCD-RAW file located on an
external storage unit that is
connected via USB✽.

If the available memory is
less than the amount
specified for correct
operation, conversion is
much slower due to the
extremely high levels of hard
disk access required.

You are using the default
window size.

For more efficient conversion, you should
transfer the CCD-RAW image to your hard
disk before converting it.

Ensure that you have at least 256 MB of
memory installed in your computer.
In addition, quit as many other active
applications as possible.

Click the right edge of the window and
drag it out to resize the window. The
preview image will also enlarge to fill the
new window size.

Troubleshooting

✽ The estimated remaining times displayed by RAW FILE CONVERTER EX are calculated on the
assumption that the images being converted are stored on the computer's hard disk.
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Error message Problem Solution
Disk full. Conversion
interrupted.

Unsupported CCD
Raw file. Conversion
of this image
skipped.

Processing could not
continue due to lack
of memory.
Conversion will end.

New type of CCD
Raw data. Current
settings are invalid,
please recheck.

Settings file
corrupted.

This CCD Raw file is
not supported by the
current settings.
Specify the settings
again.

Setting save failed.

Could not import the
settings file.

Conversion could not
proceed because the hard
disk is full. Processing was
interrupted.

This message appears when
you have attempted to
convert a file with a format
other than the CCD-RAW
(RAF) format shot on a
FinePix S2 Pro.

Conversion processing
cannot be performed as
there is insufficient memory
available to the application.
Processing was interrupted.

This message appears when
you have attempted to
convert a file with a format
other than the CCD-RAW
(RAF) format shot on a
FinePix S2 Pro.

This message appears when
the imported settings file is
damaged.

This message appears when
you have attempted to
convert a file with a format
other than the CCD-RAW
(RAF) format shot on a
FinePix S2 Pro.

The disk may be full or write-
protected, or you may be
trying to overwrite another
settings file that is in use or
is write-protected.

There may be a disk error or
the settings file may be in
use by another application.

Remove some unwanted files from the
hard disk to create more space, or install
an additional hard disk.

Skip conversion of this image.

Shut down any other active applications or
install additional memory. On Macintosh
computers, increase the amount of
memory allocated to the application.

The settings used up to this point are no
longer valid. Check the settings again.

This settings file cannot be used.
Specify the settings again.

The settings used up to this point are no
longer valid. Check the settings again.

Check the remaining disk space, the file
properties and any other applications that
are running.

Test the disk and check any other
applications that are running.

Error message CAMERA SHOOTING SOFTWARE

Problem Probable Cause Solution
“FEE” is displayed
on the camera’s LCD
panel and I can’t take
pictures.

I mistakenly
disconnected the
cable when I was
using CAMERA
SHOOTING
SOFTWARE in
Windows Me and the
operating system has
reverted to a blue
screen.

If I switch the camera
off when I am using
CAMERA SHOOTING
SOFTWARE in
Windows Me, the
operating system
reverts to a blue
screen.

I mistakenly
disconnected the
cable when I was
using CAMERA
SHOOTING
SOFTWARE on Mac
OS and my
Macintosh can no
longer detect the
camera.

If I switch the camera
off when I am using
CAMERA SHOOTING
SOFTWARE on Mac
OS, my Macintosh
will not detect the
camera next time.

“Err” appears on the
camera and the
camera no longer
responds.

The aperture settings
displayed in Camera
Control (Normal)
mode do not match
the settings on the
LCD panel.

The aperture ring on the lens
is not set to the largest F-
stop setting.

Disconnection of the cable
during CAMERA SHOOTING
SOFTWARE operation is not
supported.

Switching the camera off
during CAMERA SHOOTING
SOFTWARE operation is not
supported.

Disconnection of the cable
during CAMERA SHOOTING
SOFTWARE operation is not
supported.

Switching the camera off
during CAMERA SHOOTING
SOFTWARE operation is not
supported.

The camera batteries are
flat.

The values displayed for the
aperture setting in CAMERA
SHOOTING SOFTWARE
are as follows: 1.0, 1.2, 1.4,
1.7, 2.0, 2.4, 2.8, 3.3, 4.0,
4.8, 5.6, 6.7, 8.0, 9.5, 11, 13,
16, 19, 22, 27, 32, 38, 45,
54, 64, 76, 90.

Set the aperture ring on the lens to the
largest F-stop setting.

Follow the correct shutdown procedure as
directed by the messages on the blue
screen.
Because Windows operation is not stable
once the blue screen has appeared, you
should reboot the operating system.

Follow the correct shutdown procedure as
directed by the messages on the blue
screen.
Because Windows operation is not stable
once the blue screen has appeared, you
should reboot the operating system.

Restart your Macintosh.

Restart your Macintosh.

Remove the camera batteries and use the
AC Power Adapter AC-5VH.
To use the built-in flash, you will need to
install fresh batteries.

For the precise aperture setting, use the
value displayed on the camera's LCD
panel.

Troubleshooting
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Error message Problem Solution
No memory available
in the camera.
Cannot perform
custom AWB.

Custom AWB failed.

Automatic file
numbering has
reached its limit. No
more files can be
saved in this folder.

Cannot read the
contents of the file
(filepath and
filename).

The file (filepath and
filename) already
exists. Overwrite?

The application
cannot work properly
because a necessary
file is missing or is
not compatible with
this version.

Enter number from
xxx to yyy.

Insufficient memory.

Insufficient disk
space.

Folder is not found.

Some images are left
in the camera buffer.
Clear all?

“One-push” AWB could not
be performed because there
was insufficient free memory
in the camera.

The image photographed for
use in automatic white
balance adjustment was not
suitable.

i A file with the file name
“DSCF9999.extension” has
been saved in the save
destination folder.
i The limit for the number of

files that can be saved has
been reached.

The contents of the file to be
read are not in one of the
stipulated formats.

The photography settings file
you tried to save already
exists.

A required file is missing or
the file found is an old
version of the required file.

The number you entered is
outside the valid range.

There is not enough memory
available for the CAMERA
SHOOTING SOFTWARE.

There is not enough free
space available on the hard
disk.

The save destination folder
for photographed images
(✽.jpg or ✽.tif) or photography
settings files (✽.s2p) could
not be found.

This message appears when
the software was launched in
camera priority (remote
storage) mode and there is
still image data in the
camera’s internal memory.

Delete any unwanted images from the
Scroll Preview.

Place the piece of white paper in front of
the camera again and then click the AWB
button.

Delete some of the image files in the save
destination folder or move them to another
folder.
Change the save destination folder
specified for the Save function and in the
time-lapse settings.

Delete the file that could not be read.

Change the save destination folder or the
file name for the file to be saved.

Uninstall the application and then re-install
the Hyper-Utility software as described in
“3. Installing the Software”.

Enter a new value that is within the range
given in the error message.

Close any other applications that are
running. If there is still insufficient
memory, increase the virtual memory
capacity.
On Mac OS, increase the amount of
memory allocated to the application. Refer
to the User’s Manual for the respective
operating system version for information
on specifying the virtual memory settings.

Delete some unwanted files from the hard
disk.

Check whether the folder has been
deleted before saving the file. If the folder
has been deleted, create a new folder in
the desired location and then save the file.
Refer to the manual supplied with your
operating system for information on how
to locate and create folders.

Click [OK] or [Cancel] as directed by the
message.

Error message Problem Solution
Camera is not
connected.

Cannot communicate
with camera.

Cannot take picture -
camera is out of
focus.

Insufficient battery.

Camera is not ready.

Camera error.

Hardware error
occurred.

Frame memory error
occurred.

Unexpected error
occurred.

Now charging flash ...

Camera setting is not
correct.

i The camera and computer
are not connected.

i The driver files were not
copied to the computer.

An error occurred in the
communication with the
camera.

The camera cannot take
pictures since it cannot
focus.

The batteries inside the
camera are flat.

The camera is not ready.

The camera has
malfunctioned.

A hardware fault occurred in
the camera.

A fault occurred in the
camera’s internal memory.

The camera could not take a
picture because the flash is
charging.

i The aperture on the
camera lens is not set to
“stopped down”.

i A third-party flash unit was
used and the flash mode is
not set to “TTL”.

i Replace the internal batteries in the
camera before using the Camera
Shooting Software.
i Refer to the Owner’s Manual supplied

with the camera for information on
replacing the internal batteries.
i Uninstall the application and then re-

install the software as described in “3.
Installing the Software”.

Check that there is no problem with the
IEEE1394 connection and that the camera
is switched on.

Disconnect the camera from the computer
and use the camera with the focus mode
set to Manual.
Alternatively, select Focus lock in the
application and then take the picture.

Replace the batteries in the camera
before using the CAMERA SHOOTING
SOFTWARE.
Refer to the Owner’s Manual supplied with
the camera for information on replacing
the internal batteries.

Switch the camera off, disconnect the
IEEE1394 cable from the camera and
check that “PC MODE s SHOOTING” is
selected in the camera’s SET-UP screen.
Then switch the camera back on and
reconnect the IEEE1394 cable.

If this message recurs frequently, contact
your FUJIFILM dealer or service
representative.

iWait a few moments until flash charging
is completed and then take the shot
again.
iWhen you are using time-lapse

photography, change the settings to
increase the interval between shots.

i Set the aperture on the camera lens to
“Minimum” and then take the picture.
Refer to the instructions provided with
the lens for information on how to set the
aperture.
i Set the flash to “TTL” and then take the

picture. Refer to the Owner’s Manual for
the camera and the instructions provided
with the third-party flash unit for
information on how to set the flash
mode.

Error message
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� SmartMedia
A compact memory card that uses flash memory. Used as a storage media for
digital cameras.

� TIFF
Acronym for “Tagged Image File Format”. Refers to one type of bitmap file.
This format supports grayscale and full-color images and is best suited for
saving photographic images. 

� RAF
The file extension for CCD-RAW files.

� RGB
A color model for stipulating and expressing colors using the three primary
color components of light. R, G and B, stand for red, green and blue
respectively, and this system is used for color generation in most display
monitors. When red, green and blue are all combined at 100% ratios, the
result is white. The use of combinations of these 3 colors to produce other
colors is called the additive color process.

� Color temperature
The expression of colors of light in terms of a corresponding temperature. The
unit used is absolute temperature (K: Kelvin).
Lower color temperatures tend towards red, while higher temperatures appear
blue. Sunlight on a fine day (bright daylight) is roughly 5,500K, and the light
from flash units has roughly the same color temperature.

� Color space
The color space for an input-output device such as a display monitor, scanner
or printer defines the range of colors that can be reproduced by that device. In
order to maintain a consistent color environment from input through to output,
the different color reproduction ranges on different devices must be adjusted
or regulated so that the colors produced in the I/O device and the final printed
outcome are matched.

� Color Management System
A mechanism for adjusting the color reproduction ranges and matching colors
among devices such as display monitors, scanners and printers so that the
same color tones are produced. The color management systems offered by
the different operating systems are “ColorSync” in Macintosh systems and
“Image Color Management ICM” in Windows systems.

� Gamma
Gamma (γ) is used in electronic imaging fields such as video as a method for
expressing tonality. There is an exponential relationship between output and
(input)γ. Larger gamma values give a more steeply bowed gamma curve, such
that the image is darker than the input image when γ>1 and lighter than the
input image when γ<1.

9 Glossary of Terms
� CCD-RAW
These are images shot when “CCD-RAW” is selected as the HIGH mode
setting on the FinePix S2 Pro. The raw (unprocessed) output from the CCD
(pickup element) is saved.
Saving images in CCD-RAW format allows the images to be saved with no
loss in image quality.
To use CCD-RAW images in applications such as Adobe Photoshop, RAW
FILE CONVERTER EX must first be used to save the images again in the
TIFF file format.

� CMS
Acronym for Color Management System.

� ColorSync
A color management system devised by Apple Computer, Inc.

� CompactFlash
A compact removable flash memory card. Used as a recording media for
digital cameras.

� Exif
A full-color still-image file format for digital still cameras approved by the
Japan Electronics and Information Technology Industries Association (JEITA).
Exif is compatible with JPEG and TIFF and can be handled by most image
processing software applications. The Exif format also stipulates the recording
method for thumbnail images and camera information.

� FireWire
A high-speed serial communications protocol devised by Apple Computer, Inc.
FireWire is the same as the “IEEE1394” protocol.

� ICC
Acronym for “International Color Consortium”. The ICC is a global
organization set up to standardize color management systems. The “ICC
profiles” standardized by the ICC are industry standard formats that stipulate
the device information used by color management systems.

� IEEE1394
Standard for a high-speed serial interface. Allows high-speed data transfer
between computers and peripheral devices such as MO drives or digital
cameras via a cable connection.

� JPEG
Acronym for Joint Photographic Experts Group.
A file format for compressing and saving color images. The compression rate
is selectable, but the higher the compression rate, the greater the
deterioration in the quality of the expanded (restored) image.
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� Color
Saturation indicates the intensity of a color. When a color has a high
saturation value, the color tone is intense and clear. In the same way,
brightness indicates how bright a color appears.

� Gamut
Gamut refers to the range of colors that can be reproduced on a display
monitor or in printing. The range of colors visible to humans is wider than the
colors included in color models such as RGB and CMYK, and not all colors
can be reproduced on a display monitor or in print. There are significant
differences between the gamut for the basic RGB (red, green, blue) additive
color process (for digital cameras, scanners and display monitors) and that of
the CMYK (cyan, magenta, yellow, black) subtractive color process (for
printers).

� Sharpness
Refers the clarity of the edges in an image. The sharpness is determined by
the balance of resolution and contrast, and sharpness deteriorates when that
balance in poor. The sharpness of an image can be adjusted to some extent
using image processing software.

� Gray Picker
A tool used for specifying intermediate tone points (points of intermediate
color tone in an image).

� Sensitization
Adjusts the brightness.

� Tone Curve
The tone curve visually represents the tonality (brightness and contrast) of an
image and can be used to adjust that tonality. Changing the shape of the
curve changes the relationship between the input (the source image colors)
and the output (the way the input image colors appear in the final image).
Consequently, the tone curve can be used to make fine adjustments to
brightness and contrast in a specific tonal range.

� Histogram
An image brightness distribution chart. The horizontal axis shows brightness
and the vertical axis shows the frequency with which each level of brightness
occurs. A histogram serves as a guide to image adjustment.

� White Balance
Whatever the kind of the light, the human eye adapts to it so that a white
object still looks white. On the other hand, devices such as digital cameras
see a white subject as white by first adjusting the color balance to suit the
color of the ambient light around the subject. This adjustment is called
matching the white balance. A function that automatically matches the white
balance is called an Automatic White Balance function.
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